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What's New?

What’s New
Lavasoft Ad-Aware® Enterprise now provides the following new features and bug fixes:

Version 2.1.0.0
New Features:
• Support for Ad-Aware® 2008
• Administrator can remotely control Ad-Watch on a single client or group of clients
• Extended threat Detection Database - Anti-spyware and Anti-virus protection
• Works on 64bit clients
• Enhanced rootkit removal system

Version 2.0.0.1
New features:
• Support for Ad-Aware® 2007
• Clients can now run Ad-Watch for real-time protection
• Administrator can set custom detection options based on TAI ratings, providing more targeted
results
• Central licensing system for all clients
• Works on Windows Vista 32-bit
• Improved Windows Group Policy deployment procedures
• Improved network traffic handling

Version 1.9.4.1
New Features:
• “Select All” and “De-Select All” options have been added to the groups tab in the server schedule
tab.
• Network- and system-resources efficiency has been updated.
• Clients automatically distribute their definition files to update over time when set to pull new
definition files.
• Clients have a registry key pointing to a local directory to store scan logs. By default <Ad-Aware
folder>/logs/
• Clients now have the option to remove old scan log files themselves. The maximum age (if any) is
set by the administrator when installing the Clients.
• Bugs Fixed:
• Clients that are immediate descendants of the server are not automatically scanned.
• 99% CPU resource usage.
• Clients only sign up to server during start-up sequence.
• Previously made settings are forgotten when browsing in the Console.

Version 1.7.0000

• Simplified the Logging function for debugging.
• Integrated an enhanced manual for Ad-Aware Enterprise.
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What's New?
Version 1.6.0001 ( Beta )
•
•
•
•

Huge performance improvements for the update of the client list.
Added more stability to the Server.
The version of the included Ad-Aware SE Professional has been updated to 1.06r1
Some additional small changes.

New features:
• Definition files can now be implemented to the clients with two different methods, pushing and
pulling.
• Alternative logging methods are now provided to the users. Disk space of the Server and Clients
can be saved by “No detailed logging” .
• Clients will automatically check the Server for a new definition files when booting.
• New key added to Registry to control the path from which Ad-Aware SE scanning logs are read.
Bugs fixed:
• Startup time always showed a “%” in “Server Control” panel.
• Notification mails were sent with incorrect time zone.
• “Force Update” now is the default setting for scheduled updating.
• Status tabs did not update in time in “Client Status” panel.
• Absent clients were not identified correctly to be absent.
• Server IP could not be allocated to assigned local network interface.
• When starting “Console”, the installing progress bar will not appear again.

Version 1.5.0001 ( Beta )
New feature: support for Ad-Aware SE Professional 1.06.
Bug fixed: Server crashed when finishing a scheduled scanning task.

Version 1.5.0000 ( Initial )
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Introduction

What is Ad-Aware Enterprise?
Lavasoft Ad-Aware Enterprise 2.1 is client-server based, centrally-managed anti-spyware software designed for
corporate environments. Safety and security are placed in the hands of the IT administrator, who is able to
centrally control the Ad-Aware 2008 software on all network clients.
The network layout of an enterprise deploying Ad-Aware Enterprise should be as follows:

Network Layout of Ad-Aware Enterprise
Note! Ad-Aware Enterprise Server and Console are normally, but not necessarily, installed on the same
computer.
Benefits
• Combating spyware in a corporate environment is simplified by allowing the IT administrator to
centrally manage Ad-Aware 2008 on all network clients.
• Let us relieve your workload. Spend more time computing and less time solving problems, knowing
Ad-Aware will block behavior-tracking spyware before it rears its ugly head.
• Increase employee productivity and enhance computer performance with top-quality protection
against bandwidth-stealing programs.
• Browse where you want. We can relieve the burden of protecting your classified business information by keeping out keyloggers and other programs that put vulnerable data at risk.
• You and your staff can download music, videos and photos without having to worry about spyware
infiltrating your system.
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Getting Started

About Ad-Aware 2008
Ad-Aware 2008 is the latest version of Lavasoft’s industry leading anti-spyware solution. Ad-Aware 2008 allows
you to combat the growing threats and latest advancements of malicious spyware and malware.
Ad-Aware 2008 protects you from spyware that secretly takes control of your computer, resulting in aggressive
advertising pop-ups, sluggish computer activity and even identity theft through stolen private information. We give
you the tools to detect hazardous content on your computer, clearly identify their threat level, and then give you
the ability to remove unwanted content, so that your private information remains right where it should - under
your control.
Lavasoft’s advanced Code Sequence Identification (CSI) technology roots out deeply hidden malware and then
searches for similar codes in order to identify emerging variants. Ad-Aware 2008 thoroughly scans your memory,
registry, Hosts file, hard, removable and optical drives for known data-mining, aggressive advertising, parasites,
scumware, keyloggers, trojans, dialers, malware, browser hijackers, and tracking components.

© 2008 Lavasoft AB
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Getting Started

Components
Ad-Aware Enterprise is distributed as a standard Microsoft Installer Package ( .MSI ). The main components
included in Ad-Aware Enterprise are shown in the below graph:

Components of Ad-Aware Enterprise

Ad-Aware Enterprise Server Service
This is the server component of Ad-Aware Enterprise. After being installed as a Windows System Service, the
Ad-Aware Enterprise Server will control clients’ behavior in the network and store information about them.
Ad-Aware Enterprise Console
This is a graphical user interface; it is the only interface to access Ad-Aware Enterprise Server Service and
Ad-Aware Enterprise Client Service. With this interface, network administrators can easily check the status of
Ad-Aware running on clients and set up updating and scanning tasks on the Server. As a separate component, it
allows administrators to remotely invoke the Server Service on another computer.
Ad-Aware Enterprise Manual
This is the manual for Ad-Aware Enterprise (you are reading it now).
Ad-Aware Enterprise Client Service
This is the client component of Ad-Aware Enterprise. Running as a Windows System Service on each network
client, it is always accompanied by Ad-Aware 2008 Pro, and makes it possible for Ad-Aware 2008 Pro to be
remotely managed.
Ad-Aware 2008 Pro
This is the anti-spyware component of Ad-Aware Enterprise running on all network clients.
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Using Ad-Aware 2007

Features
Ad-Aware Enterprise is a centralized, client-server based management tool that enables network administrators
to manage the anti-spyware software running on all computers in a corporate network. It combines the state-ofthe-art anti-spyware program Ad-Aware 2008 Pro with the Ad-Aware Enterprise Console.
Ad-Aware Enterprise Console Features
• View all registered and active clients.
• View all machines running Ad-Aware 2008.
• Update client software using .msi files and Windows Group policies.
• Update definition files on all client computers.
• Monitor the definition file version for all client computers.
• Monitor the malware detection logs from previous Ad-Aware executions.
• Monitor the Console server status.
• Scan one or more clients over the network.
• Specify notifications for events such as definition file updates and network scans.
Ad-Aware 2008 Pro Features
• User-controlled spyware removal allows you to decide what to delete and what to keep.
• Lets you customize the scanning of RAM, registry, hard drives, and external storage devices.
• Innovative CSI (Code Sequence Identification) technology detects known variants of malware and
then searches for similar codes to identify emerging, or unknown variants.
• Offers an extensive definition file library of identified and analyzed spyware.
• Malware and spyware installations blocked by Ad-Watch
• Monitor unauthorized Internet connections with Ad-Watch Connect
• Web navigation control with the Hosts File Editor
• Protection against registry changes with RegShield
• Internet surfing tracks erased by TrackSweep
• Automatic scan set-up in The Scheduler
• Incremental threat updates for faster downloads

© 2008 Lavasoft AB
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Using Ad-Aware 2007

System Requirements
•
•
•
•
•

Supported languages: English
File size: Server software: 3 MB; Client software: 15 MB
Processor: P166
Hard disk: 200 MB of free space on both server and client
Delivery: Internet download with an optional CD

Ad-Aware 2008 Enterprise Client
• Processor: Pentium III 600MHz or faster
• RAM: Operating system + minimum 50 MB (100 MB recommended)
• Hard Disk: 50 MB free space recommended
• Operating Systems:Windows Vista (32 bit), Windows XP (Home, Pro), Windows Server 2003,
Windows 2000 (Pro and Server)
• Web Browser: Internet Explorer (version 5.5 or higher), Firefox (version 1.5 or higher), or Opera
(version 9 or higher)
Ad-Aware Enterprise Server
• Operating system platforms: Windows® NT4 (Workstation/Server), 2000 (Professional/Server), XP
(Home/Professional), XP 64-Bit Edition, and 2003 Server
• RAM: Operating system + 24 MB
• 200 MB of free disk space
• Internet connection (optional; for downloading definition files)
• Mail server (SMTP) access (optional; for sending notifications by e-mail)
Ad-Aware Enterprise Console (IT Administrator)
• NT 4.0, 2000, 2003 and XP versions of Windows®
• Ad-Aware Enterprise Server Service installed
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Installation

Prerequisites
Be sure to have the correct installer package before installing Ad-Aware Enterprise. The software is distributed as
a standard Microsoft Installer Package with file name of “AAWEntServer.msi”.

Ad-Aware Enterprise installer package as it appears on the Windows Desktop
If you have already purchased Ad-Aware Enterprise but do not have the latest installer package (AAWEntServer.
msi), please contact Lavasoft to receive the download link as soon as possible.

© 2008 Lavasoft AB
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Installation

Server Installation
Note! The installer package you received contains all the programs needed for Ad-Aware Enterprise.
You need to install the Ad-Aware Enterprise Server component as the first step in extracting another Installer
package (the one for the Ad-Aware Enterprise Client component contained in the Ad-Aware Enterprise Server
component). If you are operating the Server directly, you can put the installer package you received in any
directory on the Server and then double-click the file “AAWEntServer.msi” to start the graphical installation

Selecting the Ad-Aware Enterprise Server installer package in Windows Explorer
The installer guides you through the standard installation steps. After accepting the license terms, you will be
presented with the following window that will prompt you on preferred features:

Ad-Aware Enterprise feature selection
The features are as follows:
• Ad-Aware Enterprise Console
Ad-Aware Enterprise Console is a graphical user interface; it is the only interface you can use to
access the Ad-Aware Server Service and Ad-Aware Enterprise Client Service on the network. It
can be installed together with Ad-Aware Server Service or remotely using a Windows Group Policy.
• Ad-Aware Enterprise Server Service
Ad-Aware Enterprise Server Service is a service that runs on the server and handles the communication with the clients.
• Ad-Aware Enterprise Manual
Refers to the manual you are reading now.
• Client Setup
Installer Package for client computers. After the Server is installed, you will find a new package in
the Server installation path. It can also be found as a shortcut in the Start menu.
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Installation
After choosing the features you want to install, fill in the server port number. This is the TCP port that Server
Service uses to accept inquiries from the Clients. You should accept the default port number 10020. The port
must be allowed to pass a firewall if there is one.

Ad-Aware Enterprise Server settings
To start installing, click the “Next” button. A progress window will appear; the features you selected for installation
will be installed on your server, and they will begin running automatically.

Ad-Aware Enterprise on the Windows Programs list after installation
Another MSI installer package, ”AAWEntClient.msi”, containing the Ad-Aware Enterprise Client software, will
also be extracted and placed in a subdirectory in your installation path; a shortcut for it will be placed in the Start
menu.

Ad-Aware Enterprise Client installation package on Ad-Aware Enterprise Server
“AAWEntClient.msi” can be copied to any workstation on the network for a separate graphical installation, or it
can be remotely installed using a Windows Group Policy.
© 2008 Lavasoft AB
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Installation

Verification
Here is how you can verify the installation of Ad-Aware Enterprise:
After installing the Server and Client components, the first thing you should check is your firewall settings. As
Ad-Aware Enterprise uses TCP ports for communication between the Server and the Clients, the two TCP
ports you set should be opened in all of your firewall settings, especially if there are Windows XP Service Pack
2 systems in your network.

Manually adding the Server and Client TCP ports to the firewall settings.

After setting up the firewall, you can open the Ad-Aware Enterprise Console.

Selecting the Ad-Aware Enterprise Console in the Windows Start Menu
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Installation
When you run the Ad-Aware Enterprise Console for the first time, you will be presented with the “Select server
...” panel. You need to add information about the first server to the panel so the Console can connect to the
Ad-Aware Enterprise Server Service. Click the “Add Server” button, input your server information, then click
“OK” to save your input.

Adding servers to the Ad-Aware Enterprise environment
If you entered valid information, the complete Ad-Aware Enterprise Console interface will be presented and the
options in the panel at the left will become available.
To check if all clients are already connected to the Server, please click “Client Control” panel.

List of clients running the Ad-Aware Enterprise Client in the Ad-Aware Enterprise environment
All clients running the Ad-Aware Enterprise Client should appear in the lower left-hand panel under “Machine”.
© 2008 Lavasoft AB
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Installation
After checking the connection between Server Service and Client Services, select “Server Control” panel to
check if the Server Service can access the Internet. This is necessary if there is a proxy server in your network.

Server Control panel
The Ad-Aware Enterprise Server Service uses the Internet Explorer settings to fetch new definition files from
Lavasoft’s Publishing Server via the Internet, so you should allow the Server machine to pass the proxy Server or
firewall. By clicking the “Check Ad-Aware Definition File” button, you can verify if your proxy and firewall settings
are correct. The Ad-Aware Enterprise Server Service is then able to fetch definition files.
Note! The “Check Ad-Aware Definition File” button is only used to check the Internet access and the latest
definition file version. Clicking it will not download the definition file.
After you have verified all of the above, you have successfully installed your Ad-Aware Enterprise.
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Installation

Client Installation
Note! The Ad-Aware Enterprise Server component must be installed before setting up any clients. You can install
the Client component onto client computers first, but it will not work properly until it finds a running Ad-Aware
Enterprise Server.
There are two ways to install the Ad-Aware Enterprise Client on client computers:
• The administrator can individually install the Client on each computer by first distributing the client
installation package (AAWEntClient.msi) to all clients, then double-clicking on the package on each
client. This method is available on all supported platforms, and is described in this chapter. The
“AAWEntClient.msi” package is available on the computer running the Ad-Aware Server software
after it is installed.
• The administrator can centrally install the Client software on all clients at one time by using Windows Group Policy. This method is available on Windows 2000, 2003 and higher Server editions.

Install the Client Package
You will find the installer package for clients as a shortcut in the Windows Start Menu on your Server
computer.

Ad-Aware Enterprise Client installer package in Windows Start menu

You can copy or move the installer package to another location and then deploy it to the client computers.

Ad-Aware Enterprise Client installer package in Windows Explorer

To install Ad-Aware Enterprise Client component onto a single client computer, you can simply run it as you
would any graphical installation package.
1. Within Explorer, go into the directory that contains the Ad-Aware Enterprise Client installer
package and double-click AAWEntClient_1.9.4.1.msi.

2. After accepting the license terms, you will be presented with the “Destination Folder” window
which prompts you to either accept the default destination folder or specify another:
© 2008 Lavasoft AB
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Installation

Decide the installing path
Specify the destination folder and press “Next”. The “Ad-Aware Enterprise Client” window appears:

Client settings

3. In this window, specify the following options:
Ad-Aware Enterprise Server Host
This is the HOST NAME or IP address of the Ad-Aware Enterprise Server computer, e.g., “myServerMachine” or “192.168.1.100”.
Ad-Aware Enterprise Server Port
This is the TCP port number of the Ad-Aware Enterprise Server Service you set when installing the
Server component. The Ad-Aware Client Service will send information to the Server Service using
this port. The port number needs to be the same as the one you specified for the Server Service.
The default setting is 10020. The port must be allowed to pass a firewall if there is one.
Ad-Aware Enterprise Client Port
This is the TCP port that Client Service uses to listen to all calls from Server Service. To avoid chaos
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Installation
in your network, the same port number should be specified to all client computers. The default
setting is 10010. The port must be allowed to pass a firewall if there is one.
Auto Delete Log-files
The Ad-Aware Enterprise Client will automatically remove all scan log-files after the amount of days
entered here. If the number 0 is entered, all scan log-files will be stored.
Fill in the required information and press “Next” button. The Ad-Aware Enterprise Client software
will be installed on the client, and the following window appears:

Ad-Aware Enterprise Client installation success message
4. Press the “Finish” button to complete the installation.
When completed, Ad-Aware Enterprise Client Service will automatically run as a Windows Service.
It will try to connect to the Ad-Aware Enterprise Server Service immediately using the specified
Server name or IP address and the TCP port. When the Server is found, the client information will
be sent to the Server immediately.

© 2008 Lavasoft AB
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Installation

Using Windows Group Policy
Network administrators can centrally deploy the Ad-Aware Enterprise Client to groups of client computers on
the network. When using a Group Policy, administrators must remember that it ONLY applies to clients with
Windows 2000 or above.
Note: Please read the relevant manuals on how to install software via Windows Active Directory and Group
Policy first. It is also wise to check the Windows command “msiexec.exe” for detailed descriptions on the installing
parameters.
Ad-Aware Enterprise 2.1.0.1 uses the standard window deployment method to distribute to clients, because of
this feature you can install and uninstall the application centrally.
Note: All files needed for client installation are located by default in the “C:\Program Files\Lavasoft\Ad-Aware
Enterprise\Client Setup” directory on the server.
Install the Ad-Aware Enterprise Client component:
1. Create a shared directory (on a computer which can share files with all clients in the same domain).
2. Copy the client installation package “AAWEntClient.msi “ to this directory.
3. Open your windows group policy editor and navigate to the “Computer Configuration --> Software Settings --> Software installation” directories.
4. In the “Software installation” directory add the client installer package. This will cause the client to
be installed the next time the client boots.
Note: Depending on your group policy setup you may need to log in as a client and then reboot to have the
installation take place.
Configuring the Ad-Aware Enterprise Client component:
1. Open your windows group policy editor and navigate to the “Computer Configuration -->
Administrative Templates” directories.
2. In the “Action” menu choose the “Add/Remove Templates” option.
3. Choose to “Add” a template and navigate to the “AAWEntClientTemplate.adm “ and add it.
4. Navigate to “Software\Lavasoft” directory and open the “Ad-Aware Enterprise Client” entry.
5. Choose to “Enable” and put in the appropriate information for the clients to contact the server.
This will cause the client information to be applied the next time the client boots.
Note: If you cannot see the “Ad-Aware Enterprise Client” entry, please go to the “View” menu and choose the
“Filtering” option, and uncheck the “Only show policy settings that can be fully managed” option. This will make
the entry show.
Updating the Ad-Aware Enterprise Client component:
1. Open your windows group policy editor and navigate to the “Computer Configuration --> Administrative Templates” directories.
2. In the “Action” menu choose the “Add/Remove Templates” option.
3. Choose to “Add” a template and navigate to the new “AAWEntClientTemplate.adm “ and add it.
4. Edit the properties of this entry and indicate that it is an upgrade to the previous package.
Note: Depending on your group policy setup you may need to log in as a client and then reboot to have the
installation take place.
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Installation

Registration
On the Server Settings screen, enter your license number in the License text field and press the “Register” button.
You will receive a confirmation message and information about the number of days left and allowed clients will
be displayed in the License information box.

The License information box displaying a 15-client license with 250 days left.

Note: The clients will automatically retrieve the license information from the server.

© 2008 Lavasoft AB
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Installation

Uninstallation
Uninstall via Windows
Both the Server and Client components have uninstalling interfaces in Windows.
To uninstall the Ad-Aware Enterprise Server or Client in Windows, open Control Panel, click Add or Remove
Programs, then locate the appropriate software to uninstall.

Remotely uninstall Ad-Aware Enterprise Client from a group of clients in the same domain
The uninstall the client component, you simply choose to remove it from you window group policy. Open your
windows group policy editor and navigate to the “Computer Configuration --> Software Settings --> Software
installation” directories. Then simply delete the Ad-Aware entry.
Uninstalling Ad-Aware Enterprise from a computer is a simple procedure which can be performed either
individually on a single server or client via Windows, or remotely on a group of clients using Windows Group
Policy.

19

©2008 Lavasoft AB

Using Enterprise Console

First Time Running
Ad-Aware Enterprise Console is a graphical user interface the network administrators can use to manage the
behavior of the Ad-Aware Enterprise Server and Ad-Aware Enterprise Client services in the network.
With the console, the network administrators can access the Ad-Aware Enterprise Server and have it periodically
execute scheduled tasks such as scanning the drives of the client computers, updating their definitions files over
the network and receiving e-mail notifications of the execution. The network administrators can also view the
state of the clients including activity, malware status, and definition file version.
The administrators should periodically start the Ad-Aware Enterprise Console to see which clients are registered
with Ad-Aware Enterprise Server and to monitor the log-files the console is collecting from Ad-Aware Enterprise
Server. The following chapters describe these tasks in more detail.

To open Ad-Aware Enterprise Console:
In the Windows “Start Menu”, click the “Ad-Aware Enterprise”, then the “Ad-Aware Enterprise Console”. The
Ad-Aware Enterprise Console will start with the following empty panel:

Ad-Aware Enterprise Console startup screen
The options in the left pane for controlling the Ad-Aware Enterprise Server and Clients are the following:
• Server Settings: Allows the administrator to specify general settings for the Ad-Aware Enterprise
Server
• Server Control: Indicates the current state of the Ad-Aware Enterprise Sever
• Notifications: Connects the Ad-Aware Enterprise to the administrator’s messaging system (currently
SMTP is supported)
• Server Schedule: Allows the administrator to schedule tasks
• Client Control: Allows the administrator to check which clients are registered and view clients’
Ad-Aware log-files

The “Connect” icon
The “Scan” icon

© 2008 Lavasoft AB

allows you to connect to the selected Ad-Aware Enterprise Server.
allows you to scan selected clients for malicious content.
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Using Enterprise Console

Server Settings
Selecting “Server Settings” from the options menu displays the server setup panel, which is the first panel you
should fill out as it allows you to provide the basic settings for Ad-Aware Enterprise.

The settings panel
Mail Settings
The mail settings are needed for the Ad-Aware Enterprise to be able to emit notifications for the various
events.
• SMTP server address: This is the hostname or IP address of your mailserver. Leave it blank if you do
not have such a server.
• Sender address: This is the address to be used for logging into the SMTP server. Make sure the
address is valid in case your SMTP server performs a check of the sender address.
• Sender name: This is the clear-text name that appears in the From-line in your mail client. Choose
a name that you can easily associate with the Ad-Aware Enterprise notifications (e.g., “Ad-Aware
Enterprise notifier”).
Definition File Update
• Push definition files from the server to the clients: This option lets the Ad-Aware Enterprise Server
perform the definition file update.
• Let the clients pull the definition files from the server: This option lets the Ad-Aware Enterprise
clients perform the definition file update. This is the best choice for the most efficient use of
network- and system-resources. The clients then decide for themselves when the update of the
definition file should occur. The primary time is set by the administrator but the clients distribute
their updates over a period of +/- 3 hours depending on their IP-address.
Advanced Settings
Debugging information:
• No detailed logging: Information is logged but not for debugging purposes. Logs contain only very
basic information to help keep log volumes manageable.
• Basic error logging: Information is logged for debugging purposes. Logs will be moderate in size.
• Detailed error logging: Both debugging and tracing information are logged. Logs will grow to a
considerable size.

21
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Using Enterprise Console

Server Selection Options
The Ad-Aware Enterprise environment allows more than one server to run the Ad-Aware Enterprise Server
software.
Creating a list of Ad-Aware Enterprise Servers
To create a list of servers running the Ad-Aware Enterprise Server:
1. In the “Edit” menu, click “Edit Servers”. The “Select server...” box appears:

The server edit window
2. Click “Add Server”.
3. For the server you are adding, fill in the following information:
•
•
•
•

Connection name: The clear text name of the server.
Server hostname : The IP address of the server.
Server port: The port number the server uses to communicate with the clients.
Connect to this server on startup: Make the server your default Ad-Aware Enterprise Server.

4. Click “Add Server” to save the information.
5. Repeat steps 2-4 to create another server.
6. Click “OK” to close the “Select server...” window.

© 2008 Lavasoft AB
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Using Enterprise Console

Connecting to Ad-Aware Enterprise Server
To connect to a server running the Ad-Aware Enterprise Server:
1. Click the “Connect” icon . The “Select server” window appears:

The server selection window
2. From the window, select an Ad-Aware Enterprise Server you wish to connect to and press “OK”. You are
connected to the selected server.

Disconnecting from Ad-Aware Enterprise Server
To disconnect from an Ad-Aware Enterprise Server you are connected to, in the “File” menu, press “Disconnect”in
the “File” menu.

The server disconnect window.
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Using Enterprise Console

Server Control
Selecting “Server Control” from the options pane allows you to easily view the current state of the Ad-Aware
Enterprise Server, as well as to start and stop it.

The Ad-Aware Enterprise Console Control panel
The first line in the panel shows the current state of the Server Service. This line normally reads “’Service is
running” or “Service is stopped”. In the image above, the line reads “Status is unknown”, which is a special state
indicating the service was installed improperly.
In order to start the service, click the “Start Service” button. This button changes into “Stop Service” as soon as
the service is up and running.
The third line shows the current up-time and the start-up time of the server respectively.
You can also check whether a new definition file is available for Ad-Aware 2008 Pro by clicking the “Check
Ad-Aware Definition File” button.

© 2008 Lavasoft AB
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Using Enterprise Console

Notifications
Selecting the “Notifications” in the options panel will allow the administrator to assign notifications to Ad-Aware
Enterprise events such as network scan startups and definition file updates. Only e-mail notifications are currently
implemented, however this is likely to change in the future.

The Ad-Aware Enterprise Console notification panel
The options are the following:
• Network scan finished (Result report)
• Network scan started
• Definition file update
• Definition file update error
• Server Start
• Server Stop
To add a notification or to edit an existing notification:
1. Select an event in which you wish to add a notification. The “Notifications settings” window is displayed.
2. In the window, type in the address to which you wish to send the notification.
To delete a notification:
Select the event you wish to delete and press “Delete”.
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Using Enterprise Console

Server Schedule
Scheduling is one of the most important features of Ad-Aware Enterprise. It allows you to periodically execute
specific tasks and thus automate the usage of Ad-Aware within a local network.
Selecting the “Server Schedule” option in the left-hand panel will display the following scheduling options in the
right-hand panel:

The Ad-Aware Enterprise Console scheduling panel
The tasks currently able to run are:
• Update definition file to clients: Checks the Lavasoft website for updates of the definition file and
distributes the definition to the selected groups of clients
• Scan groups of clients: Scans the selected groups of clients. Applies the scanning options set in the
‘Options’ pane during the scan
To set up a task:
1. Press the upper “Add” button. A window will appear.
2. Select the task you’d like to perform periodically and press “OK”. A new task will be created.
3. Select the group(s) you want the schedule to apply to.
4. Select the task you just created, and, under “Execution options”, check the days of the week on
which to perform the task.
5. Under “Scheduling”, choose which day(s) of the week to perform the task.
6. Enter the time of day at which to perform the task in the input field and then press “Add”.
7. Press “Apply changes” to make your changes available to the server. Your task will now be executed
on the specified days at the specified time.

© 2008 Lavasoft AB
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Using Enterprise Console
To modify an existing task:
1. Click a task in the task list to select it.
2. Under “Scheduling”, check a day of the week to add it to the task, or uncheck a checked day to
remove it from the task.
3. Enter the time of day you wish to add to the task, then press “Add” or select a time of day you wish
to remove from the task, then press “Delete”.
4. To modify the presets of the task, click the “Options” button. For more information, see Scheduled
events options.
5. To change the affected groups, choose the “Groups” pane and mark / unmark the groups you wish
to affect or not affect.
6. If you should decide to keep your original settings, press “Discard changes”. Otherwise, press “Apply
changes” to make your changes available to the server. Your task will now be executed on the
specified days at the specified time.
Note! It is NOT necessary to restart the Ad-Aware Enterprise Server in order for your changes to immediately
take effect.
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Scheduled Events Options
The two schedulable tasks (updating the Ad-Aware definition file and scanning the entire network) both have a
set of options which provide more fine-tuned control over the action the task executes. Common in both task
types is the option to choose which groups will be affected by the task. Click on the Groups pane and mark or
unmark the groups you wish to add or remove from the list of affected groups..
To specify more options for a scheduled task:
In the “Server Schedule” screen, select a task. Depending on the task, either the “Update Options” or “Scan
Options” window is displayed.
If you selected the “Update Ad-Aware definition file”, the following window appears:

The update options window
To have updates performed independently of the date of the definition file on the Internet, select the “Force
Update” option and press the “OK” button. It is recommended to enable this option for Ad-Aware 2008 Pro
because it is more failsafe.
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If you selected the “Scan Options”, the following window appears:

The scan options window
The options are divided into multiple sections:
The Scan Mode section allows you to decide whether scanning should be performed in “Smart Mode” or
whether a”’Full Scan” should be performed. In general, a “Smart Scan” is quicker than a “Full Scan”, which is more
comprehensive.
The Additional Scan Areas section provides you with the ability to choose whether just the system drives or all
drives of the clients are scanned.
The Options section provides access to the more fine-grained options of Ad-Aware 2008. These are:
• Scan Archives: Enables the scanning of internal archives.
• Automatic Cleaning: Found malware with a TAI equal to or the indicated number or higher are
automatically removed
• Perform aggressive memory scanning: Ad-Aware 2008 Pro will unload critical processes and delete
the corresponding files immediately.
Select the desired options, then press the “OK” button.
In the Extended scanning options you can modify the scanner extensions options.
• Click on Use scanner extensions to turn this option on.
• Click on Use Heuristics on extended scan to turn this option on.
• You can change the Heuristics Level from the default Level.
• Level 1 Heuristics (default)
• Level 2 Heuristics
• Level 3 Heuristics

Select the desired options, then press the ‘’apply changes’’ button.
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Client Control
Selecting “Client Control” from the options panel allows the administrator to select a client and, on the selected
client to do the following
•
•
•
•
•

view log-files
check the current Definition File version
check the date of the last scan
check the highest detected threats in the TAI *
start a scan

Note! *Short for “Threat Analysis Index, the TAI is a scale of negligible (0) to 10 used by Ad-Aware 2008 Pro to
assess the threat the detected, possibly malicious, content poses. When viewed with Ad-Aware 2008, a TAI value
is shown in the scan log next to each detected item, helping the user to decide whether or not to remove the
item. Ad-Aware 2008 Pro provides a link to the Threat Analysis Index.

The first Ad-Aware Enterprise Console monitoring panel
Viewing Scan History on Clients
To view the log-files on a particular client:
1. In the lower left-hand pane under “Machine”, select a client. A list of log-files on the selected client appears
in the main pane under “Scan history”.
2. From the list, select a log-file. The file content will appear under “Log file”.
Note! As the log-file list tends to grow over time, occupying space on the server, you may want to periodically
clear the log-file history. You can do so by pressing “Clear history” which deletes all archived log-files on the
server.
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Scanning Clients
Another important feature of the “Client information” panel gives the administrator is the ability to manually scan
any of the clients.
To scan a client:
1. In the lower left-hand pane under “Machine”, select a client.
2. Click the “Scan” icon . Scan on the selected client is started, and when the scan is complete, a new log-file
will appear in the “Scan history” list.
Viewing Detailed Information on Clients
Selecting the “Machine information” tab allows the administrator to view detailed information about a selected
client:

The second Ad-Aware Enterprise Console monitoring panel
The information includes
• the current version of the Ad-Aware Enterprise Client software
• the release date of the current Ad-Aware 2008definition file (if applicable)
• the date and time of day the client was scanned the last time
• the highest detected TAI (Threat Analysis Index)
• the Ad-Watch status
To activate/disable Ad-Watch on a client or group of clients:
In the lower left-hand pane under “Machine”, right click on a client or group of clients and click on Activate or
Disable Ad-Watch.
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About
Selecting the “About” option in the “Help” menu will display the below screen:

The screen shows
• current version of the Ad-Aware Enterprise Console
• name of the Ad-Aware Enterprise license holder
• number of clients that can be concurrently registered with the Ad-Aware Enterprise Server
• the duration of the trial period (for temporary licenses)
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Troubleshooting
Why can’t my Enterprise Console connect to the Server Service?
To correct this problem:

1. Make sure you have installed the latest version of Ad-Aware Enterprise: 2.0.0.1
Make sure that the Ad-Aware Enterprise Server service is running.
To do so, in Windows, first open “Control Panel”, then “Administrative Tools”, then “Services”.
In the “Services” list, locate the “Ad-Aware Enterprise Server” service. Make sure the Ad-Aware
Enterprise Server is started.
2. Check the IP address your Ad-Aware Enterprise Server service is using.
This is necessary only when your Server machine has two or more NICs connecting it to network
nodes. The problem may be caused by the fact that the Ad-Aware Enterprise Server service is
executing a wrong IP binding.
To check your IP address, type command “netstat -na” on the Windows Command Line. This will
display the list of IP bindings on your Server machine. In the list, find the port number you assigned
to the Server service, such as 10020, then the IP address of the Ad-Aware Enterprise Server
service which is located to the left of the port number. For example, suppose one of the entries in
your list is “TCP 192.168.1.100:10020 0.0.0.0:0 LISTENNIG”. In the entry, “192.168.1.100 indicates
your IP address.
Once you know the exact IP address of your Server, check the “Server Select” panel in Management Console to make sure it contains the correct IP address.
After resetting the Server IP address in Management Console, save it and restart Management
Console to see the changes.
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How do I pass the proxy server to get Definition Files?

To judge if your Ad-Aware Enterprise Server can download definition files without problem, click the “Check
Ad-Aware Definition File” button.
If clicking the button results in a success message as shown below, the connection is working. This is an easy and
quick way to check your proxy server or firewall settings.

Checking whether or not you can bypass the proxy or firewall
However, if you get a failure message, do the following:
As the Ad-Aware Enterprise Server uses the IE proxy setting to fetch definition files via the Internet, first click
“Start Menu” to open “Control Panel”, then “Internet Options”, then “Connections” and then “LAN Settings”.This
will display more settings for the TCP port you can modify to pass your proxy server.
After you have modified the settings but still cannot successfully connect to the Lavasoft publishing server although
you can use IE without problems, please try to give the Ad-Aware Enterprise Server service a service account
to bypass the Proxy Server.
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Must Ad-Aware Enterprise Server and Console reside on the same computer?

If you install the Management Console and the Ad-Aware Enterprise service on separate computers, the
Management Console will lose only one ability: a console installed on a remote computer will not be able
start or stop the Ad-Aware Enterprise Server service. This is a limitation of the Windows Service management
mechanism as Windows Services cannot be operated remotely.
All other Management Console functions will remain unaffected.
Start Server and Stop Server options are not available on a remote Management Console

Why didn’t the Definition Files update?

Note! After the definition files have been pulled or pushed to the clients, they will not be deployed until a
scanning operation has been invoked on the clients by the Ad-Aware Enterprise service. This means that the
updated definition files will not be activated even if Ad-Aware 2008 Pro starts a new scan. The only way to
activate the new definitions file is by running a scan that is invoked by the Ad-Aware Enterprise service.
We suggest that you arrange a scan to occur close after a scheduled updating task finishes, after 10 minutes. Once
both tasks are complete, you will find that the definition files on the client computers have been updated to a
new version.

What is the difference between pushing and pulling?

Pulling and Pushing are the two methods available for clients to get definition files from the Server.
Pulling offers better performance in a network which has more than 20 clients in the same domain.
When the number of nodes in the network is less than 20, the pushing method will provide a more effective
performance.
The “Force Updating” option found in the Scheduled Updating option panel, is more suitable for the ‘Pulling
method.
If you are using Ad-Aware Enterprise in a big network, we recommend you use the pulling method and disable
the “Force updating” option.
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Why did scanning not delete the detected malware?

If you performed a scan and found that the detected malware you expected to have been removed by the scan
was, in fact, not deleted, open the “Scheduled Scanning Options” option panel and make sure the “Automatic
Cleaning” checkbox is checked. This will cause the detected malware to be removed after scanning.

Scheduled Scan Options

What is the difference between a scheduled and a manual scan?

If you perform a manual scan, you first select an individual client from the list of client computers, then click the
“Scan” icon or the F11 key. A manual scan is always targeted at a single computer.
When you perform a scheduled scan, you first select the scanning options you want to use and then select the
days of the week and the time of day on which you want to run the scan. A scheduled scan is always targeted at
all clients that are currently registered with the Server.
Unlike scheduled scanning, manual scanning does not allow you to change the scanning parameters before you
run the scan; instead, it will use the default settings, running a Full Scan and automatically deleting any objects
found that have TAI higher than 3.

Why are some clients shown in red?

On occasion, you may see a red cross next to some clients in the Management Console. This means that the
clients were originally registered with the Ad-Aware Enterprise Server but that then something changed with the
connection. The most common cause of the problem are the IP addresses of your clients, which are managed by
DHCP and which are changeable.
To correct the problem, restart the Ad-Aware Enterprise Client on the clients whose IP address has changed.
Upon startup, Ad-Aware Enterprise Client service attempts to re-register with the Ad-Aware Enterprise Server.
Normally this should correct the problem, but if the problem continues, check it if the firewall settings of your
client have changed. If they are, you may need to open the TCP port for your Ad-Aware Enterprise Client.
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Can Clients update Definition Files without a Server?

Yes. Even without an Ad-Aware Enterprise network, Ad-Aware 2008 Pro will be installed on your client and can
still perform scanning and updating definition files singularly.
If this is your situation, you need to start the Ad-Aware 2008 Pro software from your local disk. You can find the
software in the Ad-Aware 2008 installation directory (default folder: C:\Program Files\Lavasoft\Ad-Aware 2008).
After opening Ad-Aware 2008 Pro by double-clicking “Ad-Aware2008.exe”, you can start using this software as a
stand-alone Ad-Aware 2008 Pro package. All the functions will be the same as in the Enterprise Edition including
modifiable scanning settings and definition file updating. You can also start Ad-Aware 2008 Pro by using the
shortcut on your Windows desktop.

Ad-Aware 2008 Pro as a stand-alone application on a client
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Corporate License Agreement
This license agreement (hereinafter the “Agreement”), is entered into between Lavasoft AB, 556629-6470 •,
(“Licensor”) and [Name, Reg. No. •], (“Licensee”). Licensor and Licensee are referred to in this Agreement as
“Party” or “Parties”.

1. Background
1.1 Licensor holds all intellectual and proprietary rights pertaining to the software Ad-Aware (the “Software”).
The Software includes updates, upgrades and new releases of the Software which have been made officially
available for the Licensor’s licensees.
1.2 This Agreement contains the terms and conditions for Licensee’s right to use the Software.
1.3 This Agreement does not contain the terms for the other services related to the Software such as installation,
adaptation, implementation and conversion of data, support and maintenance (other than as set forth in Section
8) or training. Such services may be rendered by Licensor to Licensee pursuant to specific agreements.
1.4 Licensee acknowledges that the license granted in this Agreement entitles LicenseeCon to use the Software
only on one computer installation and in relation to Licensee’s own business.

2 Definitions and Schedules
2.1 For the purpose of this Agreement, the definitions set out below will have the following meaning:
• “Agreement” shall mean this agreement including the from time to time applicable ap-pendices;
• “Confidential Information” shall mean any information and know-how related to the Software or
as otherwise provided by one Party to the other Party, provided that such information has been
identified to be confidential, or if it is obvious without such identification that the information is to
be treated as confidential. In addition, Confidential Information includes any analysis or amalgamation or compilation of the confidential information performed by the receiving Party;
• “Date of Delivery” shall mean [date];
• “Licensee” shall mean the legal entity who acquires the right to use the Software pursuant to this
Agreement;
• “Software” shall mean the object code (in machine-readable form only) to the Ad-Aware application specified in Schedule 1, including all subsequently released updates and bug-fixes, and technical
documentation relating to the Software;
• “Specification” shall mean the Software’s technical and functional specifications as set out in Schedule 1.
2.2 This Agreement has the following appendices which form an integral part hereof:
• Schedule 1
• Schedule 2
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3 License
3.1 During the term of this Agreement, and in consideration of the payment of all fees hereunder, Licensor grants
to Licensee a non-exclusive and non-transferable right to use the Software on the terms and conditions in this
Agreement.
3.2 The Software may only be used in Licensee’s own business.
3.3 This Agreement entitles Licensee to install and operate the Software on one computer installation.
3.4 Licensee may not enter into any outsourcing agreements or by any other means allow a third party to either
install or execute the Software in any computer networks without Licensor’s prior written consent. Such consent
shall not be unreasonably withheld.

4 Delivery
4.1 On the Date of Delivery, Licensor shall deliver the most current release of the Software on a compact disc
or similar media to Licensee or through electronic transmission via the Internet. The delivery shall also include
one copy of all necessary documentation regarding the Software. The Software shall be considered delivered
when the Software and the documentation is accessible for Licensee.
4.2 Unless agreed by the Parties in separate agreements, Licensor shall not be responsible for any additional
services such as (i) installation, (ii) customized adaptation, (iii) education and training in the use, (iv) implementation
and conversion of the Software, or (v) integration - through application protocol interface (API) or otherwise
- of the Software with Licensee’s other software products.
4.3 Licensee is responsible for the installation of the Software and may install the Software on one computer
only.

5 Licensee’s Obligations
5.1 Licensee undertakes to use the Software only for its sole and exclusive benefits in its own business and
undertakes not to modify, translate, reverse engineer, decompile, dis-assemble (except to the extent that this
restriction is expressly prohibited by law) or create derivative works based upon the Software or documentation.
Licensee also undertakes not to copy the Software or its documentation, rent, lease, transfer, or otherwise
transfer rights to the Software or documentation or in any other way make the Software or its functionality
available to any third party without Licensor’s prior written approval.
5.2 Licensee acknowledges that Licensor assumes no liability for any malfunctions, etc. in the Software performance
pertaining to Licensee’s computer environment.
5.3 Upon discovery of an error or malfunction in the Software, Licensee shall immediately inform Licensor
thereof in a written report. Such report shall contain a detailed description of the error or malfunction.
5.4 Licensee undertakes to see that Licensee’s use of the Software is in accordance at all times with this
Agreement. Licensee assumes full liability to pay any additional license fee to Licensor due to Licensee’s breach
of this Agreement. This provision shall not limit Licensor’s right to assert other sanctions which may be invoked
as a consequence of illegitimate use by Licensee.
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6 Delay in Delivery
6.1 Where the Software has not been delivered to Licensee on the Date of Delivery and the delay is caused
by Licensor, Licensee is entitled to rescind this Agreement provided, however, that Licensor, after confirming the
delay, has been granted a period of thirty (30) days to complete the delivery.
6.2 Where, as a consequence of a delay due to circumstances for which Licensee is responsible, Licensee has
not fulfilled its obligations pursuant to Section 5, or where Licensor is otherwise prevented from performing its
obligations pursuant to this Agreement, the Date of Delivery shall be postponed for the period of time during
which the circumstances causing the delay exist, taking into consideration a reasonable start-up period following
the cessation of the delay.

7 Price and Payment
7.1 Licensee shall pay a license fee in accordance with Schedule 2. All fees shall be subject to sales tax/VAT,
which shall be added as applicable as well as other special taxes or fees imposed by changes in public regulations
introduced after the signing of this Agreement with respect to the deliverables and services of this Agreement.
7.2 Where payment has not been made on the due date, Licensor shall be entitled to penalty interest on
overdue payments as prescribed by the Swedish Interest Act (SFS 1975:635). Where Licensee fails to pay
past-due amounts within thirty (30) days of a demand by Licensor to that effect, Licensor shall be entitled to
terminate the Agreement in its entirety by written notice. In the event Licensor terminates the Agreement,
Licensor is also entitled to damages.

8 Support and Maintenance
8.1 In consideration for the Licensee’s due payment of the license fee, Licensor shall provide Licensee with
support and maintenance services regarding the Software during the term of the Agreement.
8.2 The support services available for the Licensee shall consist of reasonable e-mail support during Licensor’s
business hours.
8.3 The maintenance services available for the Licensee shall consist of the provision of bug-fixes, new releases
of up-dates and up-grades of the Software as soon as such are made officially available by Licensor.
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9 Warranty and Liability for Defects
9.1 Licensor warrants that the Software in all material aspects will perform in accordance with the Specification.
However, Licensor does not warrant that Licensee’s use of the Software will be uninterrupted or that the
operation of the Software will be error-free or secure.
9.2 The Software shall be considered to be defective where the Software materially deviates from the
Specification, provided that Licensee has used the Software in accordance with the documentation and other
specific written instructions given to Licensee. Deviation from the Specification that are of no importance for
Licensee’s intended use of the Software shall not constitute liability for Licensor.
9.3 Licensor shall only be liable for defects reported within three (3) months from the Date of Delivery
(warranty period) and shall have no responsibility whatsoever for defects relating to the installation of the
Software, unless installation has been carried out by Licensor. Defects for which Licensor is liable shall be
rectified free of charge and without unreasonable delay after Licensor has received written notice of the defect.
Licensor shall carry out uninterrupted remedial work during Licensor’s normal working hours until such time as
the defect has been rectified. In order to be entitled to rectification, Licensee must notify Licensor in writing of
the defect immediately upon its discovery.
9.4 Licensor may rectify the defect by (i) providing a bug-fix, (ii) giving Licensee instructions of how to circumvent
the defect in order to minimize operational disruptions or (iii) giving instructions in a manner in which Licensee
itself can remedy the defect. Rectification shall be carried out without unreasonable delay.
9.5 In lieu of rectifying the defect, Licensor may supply new Software of the same release as the delivered
Software or a subsequent release of the Software.
9.6 Licensee shall be entitled to terminate this Agreement where a material defect (i.e. an error that renders
the use of the Software impossible) arises within the warranty period and where such material defect is not
rectified, or new Software is not delivered, without unreasonable delay from Licensee’s notice thereof. In the
event of termination pursuant to this section, the license fee shall be reimbursed to Licensee, subject to a
reasonable reduction for the benefits inuring to Licensee’s use of the Software.
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10 Limitation of Liability
10.1 Except as provided in Section 9 above, Licensor shall not have any liability for the functionality or quality
of the Software.
10.2 Licensor shall be liable for damage to Licensee’s property caused by negligence on the part of Licensor.
Licensor’s liability for such damage shall only cover compensation for direct losses and Licensor’s total liability
under this Agreement shall be limited to an amount corresponding to the amounts received from Licensee at
the time of the tortuous/damaging act.
10.3 Licensor shall be liable for damages, other than in cases stipulated in Sections 10.2 and 14.3, caused by
negligence on the part of Licensor as set forth below. Licensor liability comprises only direct losses and only to
an amount corresponding to the amounts received from Licensee at the time of the tortuous/damaging act or
omission.
10.4 Under no circumstances shall Licensor be liable to compensate Licensee for any indirect and/or consequential
losses including, but not limited to, loss of data, loss of profit, loss of production or other indirect damages,
regardless of its nature.
10.5 The limitations in Sections 10.2 to 10.4 shall not apply, where Licensor has acted with gross negligence or
willful misconduct.
10.6 Where Licensee is in breach of this Agreement, Licensee shall compensate Licensor for damage incurred by
Licensor as a consequence thereof, regardless of whether Licensor chooses to terminate the Agreement or not.
Where the breach of this Agreement consists of the unauthorized reproduction of the Software by Licensee,
Licensee shall pay an additional license fee for such copies and, in addition hereto, shall compensate Licensor
for damages.
10.7 Claims for compensation pursuant to this Section 10 must be made within three (3) months after the
circumstance giving rise to the claim became known to the Party claiming compensation.This limitation shall not,
however, apply to infringements of Licensor’s intellectual property rights in the Software or claims for payment
of license fee and/or additional license fees.
10.8 Licensee agrees that its exclusive remedies and Licensor’s entire liability with respect to the Software shall
be as set forth herein.

11 Force Majeure
11.1 Notwithstanding anything else contained in this Agreement, neither Party shall be liable for any delay in
performing its obligations hereunder if such delay is caused by circumstances beyond its reasonable control
(including without limitation any delay caused by any act or omission of the other Party) provided, however, that
any delay by a sub-contractor or supplier of the Party so delaying shall not relieve that Party from liability for
delay except where such delay is beyond the reasonable control of the sub-contractor or supplier concerned.
Subject to the Party in delay promptly notifying the other Party in writing of the reasons for the delay (and the
likely duration of the delay), the performance of such Party’s obligations shall be suspended during the period
that the said circumstances persist and such Party shall be granted an extension of time for performance equal
to the period of the delay. Save where such delay is caused by the act or omission of the other Party (in which
event the rights, remedies and liabilities of the Parties shall be those conferred and imposed by the other terms
of this Agreement and by law):
(a) any costs arising from such delay shall be borne by the Party incurring the same; and
(b) either Party may, if such delay continues for more than three (3) months, terminate this Agreement forthwith
on giving notice in writing to the other in which event neither Party shall be liable to the other by reason of
such termination.

© 2008 Lavasoft AB

42

License Agreement
12 Assignment of the Agreement, Change of Control
12.1 Licensee is not entitled to assign its rights or obligations pursuant to this Agreement. Licensee may not
sub-license, lease, or lend any rights obtained pursuant to this Agreement.
12.2 In case Licensee transfers a business unit to a third party in which the Software has been installed in
accordance with this Agreement, or should there be a change of control of Licensee, meaning that shares
representing more than twenty (20) percent of the shareholdings are transferred from the current shareholders
to another party or parties, Licensor shall be entitled to terminate this Agreement or - at Licensor’s choice exclude such unit from the license granted under this Agreement.
12.3 Licensor may assign its rights to a third party pursuant to this Agreement or delegate the performance of
its obligations to a subcontractor.

13 Intellectual Property Rights
13.1 All intellectual property rights in or relating to the Software including all documentation submitted to
Licensee under this Agreement, or any other work or services pertaining to this Agreement in relation to the
Software shall vest in Licensor. Licensee does not acquire any rights, express or implied, in the Software, other
than those specified in this Agreement. Licensee further agrees to take and assist Licensor in all other such
measures as are necessary to protect the intellectual property rights of the Licensor in the Software.

14 Infringement Claims
14.1 Licensor warrants that the use of the Software and documentation in accordance with this Agreement
does not infringe the intellectual property rights of any third party.
14.2 Licensor undertakes, at its own expense, to defend Licensee where claims are made against Licensee based
on infringements in connection with Licensee’s use of the Software of such third party’s rights.
14.3 Licensee hereby authorizes Licensor to defend Licensee in proceedings before courts of law as well as
in other cases. Licensor undertakes to hold Licensee harmless from claims made against Licensee based on
infringements in connection with Licensee’s use of the Software, provided that Licensee has used the Software
in accordance with the terms and conditions in this Agreement. Immediately upon receipt of such claim, Licensee
shall inform Licensor in writing and give a detailed account of the claim.
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15 Term of the Agreement and Rescission
15.1 This Agreement shall enter into force on the day both Parties have signed the Agreement and shall remain
in effect for one (1) year. If Licensee wants to prolong the Agreement, the parties shall enter into discussions on
the terms and conditions for the prolongation three (3) months prior to termination.
15.2

This Agreement may be terminated:

(a) forthwith by either Party if the other Party commits any material breach or persistent breaches of any term
of this Agreement and which (in the case of a breach capable of being remedied) shall not have been remedied
within thirty (30) days of receipt of a written request to remedy the same. The Parties acknowledge that
Licensee’s infringement of Licensor’s intellectual property rights always constitute such material breach;
(b) forthwith immediately by either Party if the other Party becomes insolvent or starts negotiations about
composition with its creditors or a petition in bankruptcy is filed or it makes an assignment for the benefit of
its creditors.
15.3 Any termination of this Agreement shall be without prejudice to any other rights or remedies a Party
may be entitled to hereunder or by law and shall not affect any accrued rights or liabilities of either Party, nor
the coming into or continuance in force of any provision hereof which is expressly or by implication intended to
come into or continue in force on or after such termination.
15.4 Upon termination of this Agreement, Licensee shall immediately return the Software, all copies thereof,
and all documentation to Licensor. In connection herewith, Licensee shall in writing certify that Licensee does
not possess, directly or indirectly, in whole or in part, the Software, documentation, or copies thereof, irrespective
of the form of such copy.

16 Confidentiality and Non-Disclosure
16.1 The Software and its documentation are confidential information and a trade secret (Sw. företagshemlighet)
of the Licensor.The Licensee agrees not to disclose Confidential Information to any third party, with the exception
of its personnel or duly authorized representatives, without having obtained advance written approval from
Licensor.
16.2 Each Party agrees to communicate Confidential Information only to its employees and only to the extent
necessary for the performance of their functions and only to the extent that those employees are bound by the
same confidentiality obligations as set forth herein. Each Party agrees not to disclose Confidential Information
to any third party whatsoever, and in particular to the competitors of the other Party, and not to make use of
the Confidential Information in the performance of projects, missions or any other works undertaken for any
other party.
16.3 The confidentiality obligation shall remain in full force and effect for a period of five (5) years following the
expiration or termination of this Agreement.
16.4 The confidentiality obligation does not concern information:
(a) which has fallen into the public domain without violating this Agreement;
(b) known by a Party prior to communication by the other Party;
(c) disclosed to a Party by a third party having the authority to disclose it;
(d) which must be disclosed by law (it being understood that the concerned Party should use all reasonable
efforts to inform the other Party of such disclosure and to limit the required disclosure).
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17 Amendments to the Agreement
17.1 This Agreement may only be amended by a written agreement duly executed by the Parties. This does not,
however, in any way limit the right of Licensor to determine its prices and to revise the license fee.

18 Disputes and Choice of Law
18.1 This Agreement shall be governed by and construed in accordance with the laws of Sweden.
18.2 Any dispute, controversy, or claim arising out of or in connection with this Agreement, or the breach,
termination or invalidity thereof, shall be settled by arbitration in accordance with the Rules of the Arbitration
Institute of the Stockholm Chamber of Commerce. Irrespective of the provisions set forth above, any demand
under SEK 500,000 shall be conclusively settled by arbitration in accordance with the Rules for Expedited
Arbitration of the Arbitration Institute of the Stockholm Chamber of Commerce.
18.3 The location of the arbitration shall be Stockholm. Unless otherwise agreed between the Parties, the
language to be used in the arbitral proceedings shall be Swedish.
18.4 Notwithstanding the above, in respect to any overdue payments by Licensee, Licensor shall be entitled to
initiate legal proceedings in a court of competent jurisdiction in Sweden or at the Swedish Executory Authority
(Sw. kronofogdemyndigheten).

19 Entire Agreement
19.1 This Agreement, including appendices hereto, constitutes the Parties’ entire agreement. The provisions of
this Agreement and appendices hereby supersede all written or oral undertakings and commitments, including
program specifications and suchlike, drafted prior to the Agreement.
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Contact Information
Support Inquiries
Please contact the Lavasoft support team through the Support Center
www.lavasoft.com/support/supportcenter/

Address
Lavasoft AB
Odinsgatan 10
411 03 Gothenburg
Sweden
Fax:

+46-(0)31-15 69 10
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